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Welcome to GMT!

Congratulations on acquiring Graphical MIDI Tools (GMT)! This plugin extends Si-
belius functionality by adding a piano roll view of your score. With it you can fine 
-tune the playback of your written music.

Now you can create more realistic MIDI mockups of your score, all within Sibelius. 
Its interface will allow you to:

	◼ Adjust the sound start and duration of notes.

	◼ Edit note velocities.

	◼ Draw your own automation curves for any MIDI continuous controller 
(CC) and pitch bend.

	◼ Edit the tempo curve (BPM) graphically to incorporate subtle tempo in-
flections.

	◼ Insert Phantom (hidden) notes that are performed on playback but do not 
alter the written score.

GMT online resources
We recommend you read this manual to get the most out of GMT. You can also find 

videos,  additional resources, and the latest software updates in our official website.

www.graphicalmiditools.com

If you encounter any issues, please don’t hesitate to contact support at:

support@graphicalmiditools.com

And be sure to follow us on Instagram to stay up-to-date with the latest GMT news:

instagram.com/santiagobarxmusic

It’s great to have you on board! We hope you enjoy using this plugin as much as we 
enjoyed creating it!  So, without further ado, let’s start graphical MIDI editing.

 Santiago Barx  
Composer, founder and creator
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Installation and Activation

Running the installer
Run the Graphical MIDI Tools  installer which comes with the downloaded .dmg 

(on Mac) or .zip (on Windows) file.

	◼ On Mac: double click on the Graphical MIDI Tools [version].pkg to run 
the package installer.

	◼ On Windows/PC: double click on Graphical MIDI Tools [version] installer.
exe to run the install wizard.

Then complete the package installer (Mac) or setup wizard (PC):

The Graphical MIDI Tools 2 package Installer (Mac)

2 



6  Graphical MIDI Tools | User’s Manual

b. Once the installer process is completed, open Sibelius. 

 You should see the “Graphical MIDI Tools” option added to the “Plug-ins” menu 
(in the “Home” tab).

 

The Graphical MIDI Tools 2 Option in the Plug-ins menu

Enable Sibelius Connect (Sibelius 2024.3 onward)
If you are using Sibelius 2024.3 or higher, enable the Sibelius Connect feature in 

order for GMT to be able to communicate with Sibelius.

 To do so go to File > Preferences.

	◼ Select the Input Devices category

	◼ Search for the Sibelius Connect section and tick “Allow Sibelius to be 
remotely controlled by other applications”

	◼ Leave the Network port to its default value (1898)

Tip: Assign a keyboard shortcut for faster usage
With the Sibelius Connect feature enabled, GMT is ready to work. For earlier ver-

sions of Sibelius, GMT communicates using the keyboard shortcut method.

While you can technically launch GMT from the menus, we highly recommend as-
signing a keyboard shortcut for a faster and smoother experience. 

To do so, follow the instruction in the next step.



 Installation and Activation 7

Assign a keyboard shortcut (earlier Sibelius versions)
If you are using an earlier version of Sibelius, you must use the GMT legacy com-

munication method, which requires asssigning a keyboard shortcut to the plugin.

If you have Sibelius 2024.3 or higher, GMT will use Sibelius Connect to communicate with Sibelius. 
 
Assigning a keyboard shortcut is technically optional but highly recommended to enhance 
the speed and efficiency of using GMT.

Assigning the keyboard shortcut
a. In Sibelius, go to File > Preferences. From the left column select “Keyboard 

Shortcuts”. You should see the following dialog:

	◼ (1) In “Tab or Category” choose “Plug-ins”.

	◼ (2) In “Features” search for the option “Graphical MIDI Tools 2”. 

	◼ (3) Click on  the“Add…” button.

Notice: If this is the first keyboard shortcut you add, Sibelius will ask you to create a new “short-
cuts set”, since the “Standard” set cannot be overridden. Click “Yes” and indicate a name for the 
shortcut set (for example “My shortcuts”)
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b. Choose a shortcut key. 

IMPORTANT:  The shortcut key must be a single key and not a combination. Using modifi-
ers (SHIFT, CONTROL or ALT) is not allowed, because these are reserved for GMT functionality.

In this example, we use the “Tab” key but you can choose the one that works best 
for you. Another good choice is for example the “U”, which by default is unused by 
Sibelius.

Using “U” as a shortcut key
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First Run and Activation
GMT works on a bar basis. To start it up, first select one or more measures from a 

staff in the score. 

Press the plugin shortcut key (e.g. “U”). Since this is the first run, the activation 
window will appear, requesting your email and License Key.

Enter both credentials and click  the “Activate” button. An internet connection is 
required to complete the product activation.

Offline Activation (optional)
Alternatively,  you can use the offline activation option if your computer is not con-

nected to the internet. Click on the “Offline Activation” button.
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A key file  (which contains your license information) will be required.

To obtain a key file follow these steps:

1. Using a computer with an internet connection  visit:

www.graphicalmiditools.com/offline

2. Fill in your email and license/trial key.

3. Your machine ID will be requested too. This code is  provided to you in the Offline 
Activation window.

4. Download the file and save it in a portable storage (e.g USB drive) device.

5. Load the file with the “Load Key File” button.
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The Welcome Window
On Activation success, the GMT welcome window will appear. Press “continue”.

Confirming the Keyboard Shortcut (Sibelius Versions Prior to 2024.3)
Only for users on Sibelius versions prior to 2024.3, which lack the Sibelius Connect 

feature, GMT will prompt you to specify the shortcut key assigned to the plugin.

Ensure that you enter the exact shortcut key you configured in Sibelius..
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Press “Next”. GMT will ask you to perform a test to check that the plugin key is 
correctly set and commmunication with Sibelius can be established.

Press “Test the Plugin key” to start the test.

How GMT shortcut key works (in the lack of Sibelius Connect) 
 
GMT simulates a key stroke and sends it to Sibelius every time it needs to connect with it (to 
send and receive information). By triggering the “Manuscript plugin” both applications can 
communicate between each other.  

For Mac users: Granting permissions
If you are on MacOS version 10.15 (Catalina) or higher, a System Preferences dialog 

will appear asking you to grant permissions to the application. This is needed by 
GMT for the purpose of sending the virtual key event.
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In the system preferences, click on the lock (at the bottom left), then check the 
“Graphical MIDI Tools” item in the list.

Then click on the “Try Again” button. The test should succeed.

That is all!
Once the plugin key is succesfully tested you are ready to use GMT. The piano Roll 

window should appear.

GMT’s piano roll window 
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Issues while installing? Contact us!
If you encounter any issues while setting the plugin key or installing GMT, please 

don’t hesitate to contact our support team at: 

support@graphicalmiditools.com
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The Piano Roll Window

Opening the Piano Roll window
GMT works on a bar basis. To launch it, select one or more measures in Sibelius, 

then press the plugin’s shortcut key.

To open GMT select one ore more bars in the score 
 and press the plugin’s shortcut key

The piano roll window will open, showing the region you have selected.

3 
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Getting started with GMT’s interface
These are the main areas of GMT’s interface:

1. Piano roll grid

10. Solo/Mute
buttons

2. Automation tabs

3. Toolbar

8. Timeline

5. Close button4. Transport Bar

6. Zoom 
wheels

7. Con guration 
button9. Velocity Tab

	◼ 1. The piano roll grid: Here you will be able to edit the sound start and dura-
tion of notes, or insert phantom (hidden) notes.

	◼ 2. The automation color tabs: These tabs open the automation lanes for the 
MIDI CC controller set in the configuration dialog

	◼ 3. The toolbar: Pick between the Pointer tool to modify written notes or 
the Phantom tool to add phantom notes. Here you can also set up the grid 
snapping value.

	◼ 4. The transport bar: A play button to start/stop playback. Two displays 
show the current bar/beat/tick and the minutes/seconds. 

	◼ 5. Close button: Closes GMT’s interface. To re-open select again one or 
more measures and press the plugin’s shortcut key.

	◼ 6. Zoom wheels: Click and drag over them to zoom horizontally or verti-
cally.

	◼ 7. The Configuration CFG button: Opens the configuration/preferences 
dialog.

	◼ 8. The time line: Displays the bar numbers and beat divisions of the region 
in the score. Click on its lower part  to move Sibelius’ playback line posi-
tion.   
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In here you will also find the play from button, which is  a handy alterna-
tive to to start playback from the desired position.

	◼ 9. Velocity tab: Click on it to show the Velocity lane and edit note velocities.

	◼ 10. Solo/Mute buttons: These will solo or mute the staff (similar to what is 
done in Sibelius mixer)

Expanding the selected region
It is possible to expand the selected region of the score once GMT is open (avoiding 

the need to close and re-select). To do this, click on any side of the roll grid.

You will notice that the bar to be added is highlighted in blue, and with an arrow 
pointing to the expand direction.

 

Click on the left or right side of the roll grid to expand the selection.

 As you expand your selection, the window will auto-resize to fit the new contents, 
until the physical limits of the screen are reached.

Moving and resizing the window

To move the window:
To reposition the window on the screen click over the top gray bar and move the 

mouse while holding down the left mouse button (“drag”).
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To resize the window:
You can resize GMT’s window to your needs. Click and drag on any border of the 

window. 

Zooming in and out
In GMT, you can zoom in or out using several methods.

	◼ 1. Click and drag the mouse over the “zoom wheel” controls.

	◼ 2. Use the mouse physical scroll wheel to zoom in vertically.

	◼ 3. Alternatively, you can click on the upper part of the time line (the dark 
one displaying the bar numbers) and drag up or down to zoom horizon-
tally.

Click and drag over the timeline to zoom in / out horizontally
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The Transport Bar and the Play Button

The transport bar includes a Play Button which triggers playback from the current 
playline position.

You can also start/stop playback using the                   bar while GMT window is open

The current playline position
Two different displays show the current playline position. The first in musical units 

(bar, beat, and MIDI tick).

The second one shows the current hour/minute/second. This can be quite useful, 
for example, when scoring to picture.

The Playback Line and the  Play-From Button
One handy feature of GMT is controlling Sibelius playback line position from the 

timeline.

Click on the blue area to position the playback line wherever you want.

Click on the time-line’s lower part to position the playback line.

The  Play-From button
At the top of the playback line (when playback is stopped) you will find the Play-

From button. You can click on it to start playback from a specific position in the 
timeline.

The  Play-From button allows you to quickly play 
 a passage from a specific score position.

SPACE
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GMT and playback control 
As playback progresses you will see the green line moving horizontally across the 

piano roll.

Note: This behaviour is possible if using GMT’s own control buttons. If you start playback from 
Sibelius’ play button, you will listen to the score with all your edits, but the GMT’s playback line 
will not progress.
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Editing the start and duration of a 
note’s sound

With GMT it is possible to change the sound start and duration of a note in the 
score. These modifications do not affect the written score, but only the playback.

Fine adjusting where a written note sound should start (or its duration) allows you 
to create more realistic/human-like  MIDI mockups. 

You can, for example, produce a slight arpeggio over a written block chord, emulate 
a rubato passage, or tailor performances where strict note values are not desired. 

Using the Pointer Tool
In the toolbar, make sure the Pointer tool (little arrow) is selected.

To change the position of a sound, click and drag over a note in the piano roll.

Click and drag over a note’s to reposition it’s sound

You can also modify the start and/or duration only, by clicking and dragging over 

4 
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the note edges.

The gray line represents the written note
You will see that a gray line appears striking through the note’s rectangle. This line 

indicates the real position and duration of the written note. 

Notice that the line is shown only when the sound position or duration has been 
modified from the original/written one.

 

The gray lines represent the written note position and duration.

Selecting multiple notes: the lasso tool
To edit multiple notes at the same time, click and drag on an empty area of the pi-

ano roll. The lasso tool will be activated, allowing you to select multiple notes. The 
selected notes are highlighted in blue.

Selecting multiple notes with the lasso tool

You can then edit the sound parameters for all the group just as you do with a single 
note.
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Resetting the sound: the eraser tool
To reset the sound of a note to its original start position and duration (i.e. the exact 

written one), use the right mouse button. The eraser tool will be activated. Then drag 
over the notes you want to reset.

Introducing Sidelanes
If you are familiar with piano rolls, you may notice that GMT incorporated a special 

characteristic.

When a note goes off view (because it belongs to a pitch that is outside the vertical 
visible range), it doesn’t disappear completely. Instead, it is shown with a thin col-
ored line at the top or bottom of the roll grid.

We named these borders at the sides of the grid  sidelanes.

Sidelanes inform you of notes that belong to the measure but are out of the visible range.

With sidelanes you can have a bird’s eye view of all the contents within a measure, 
avoiding the need to scroll up or down.

.

Detailed view of the sidelane.
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Editing Note Velocities

With GMT you can edit notes velocities in a graphical way. To open the Velocity 
lane, click on the lower tab button labeled Ve.

The Velocity lane will show up at the bottom of the piano roll.

The Velocity lane. The gray dashed lines mean that no velocity 
has been specified by the user.

 Initially, you will see gray dashed lines below the notes. These indicate that no  ve-
locity has been specified by the user yet, so Sibelius will decide which velocity to ap-
ply (according to the current expression marking and sound library configuration).

Writing your own velocities
To specify your own velocities click and hold the mouse over the velocity lane.

5 
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Writing note velocities.

Notice how GMT paints the louder notes with a dark color, and the softer ones with 
a lighter one.

Erasing velocities
To restore the velocities to their defaults, use the right mouse button. The eraser 

tool will be activated.

As you remove your velocities, you will see  the dashed lines come back again, in-
dicating that no user velocity has been specified for the notes (i.e. let Sibelius decide 
which ones to use).
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The CC Automation Module

With GMT it is possible to draw your custom automation curves for any MIDI con-
tinuous controller (CC) or pitch bend. 

Opening the automation lanes
The automation lanes are activated through the color tabs in the upper part of the 

window. 

The upper color tabs are configurable

Each tab corresponds to a specific MIDI controller. These can be set in the configu-
ration dialog (more on this later). By default GMT comes with these factory settings: 

	◼ MOD: (MIDI CC #1) Modulation wheel 

	◼ EXP: (CC #11) Expression control

	◼ VOL: (CC#7) Volume control

	◼ PAN: (CC#64) Panning

Drawing your custom curves
To draw a curve, press and hold the left mouse button over the automation lane.  

As you move the mouse, the corresponding nodes will be inserted, sculpting the 
automation curve.

A custom automation curve for the expression (#11) controller.

The nodes are connected through ramps, producing a smooth transition between 

6 



 The CC Automation Module 27

each other. 

Using the SHIFT key to draw jump  nodes and disable the grid
Pressing the SHIFT  key while drawing will insert jump nodes. In contrast to ramp 

nodes, jump nodes change the value of the curve on the spot, without creating a 
smooth transition between the previous one.

The SHIFT key will also disable the 16th note grid on which the ramp nodes are tied. 
This allows you to draw curves using Sibelius’ maximum MIDI resolution.

Pressing the SHIFT key while drawing inserts “jump” nodes,  
and it also disables the grid, allowing you to draw freely.

About Sibelius and  MIDI Resolution 

Sibelius has a maximum MIDI resolution of 256 ticks per quarter note. 
This means that you can insert events with up to a 1/256 quarter note 
precision. This is more than sufficient for everyday applications. GMT 
works with such resolution when using either jump nodes or ramp 
nodes. With ramp nodes, the transitions between them  are  done with 
this level of detail. 
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Editing the node manually
To edit a node properties manually, hover the mouse over the numeric value and 

click on it.

The Edit Node panel will appear:

You can the enter the node value (0-127) manually, or change the node’s type (ramp 
or jump). When you are done, press ENTER  to close the panel.

Warning! GMT vs. Sibelius dynamic markings
Sibelius sends MIDI commands to the playback engine whenever it encounters an 

expression/dynamics marking (like p, f , or a hairpin) to simulate a live perfor-
mance. Normally, these correspond to the MIDI CC #11 (expression).

If you write your own custom automation curves for the expression controller over 
a passage that has dynamics markings (p, f, or a hairpin), the playback engine will 
receive two instructions, not knowing which one to follow, with unpredictable re-
sults.

Disabling the dynamics markings playback
To avoid this, you can disable the dynamics markings from being played at all. In 

Sibelius, open the inspector panel: go to the View tab, and select the Inspector op-



 The CC Automation Module 29

tion, or press CTRL  + SHIFT  + i

Sibelius’ Inspector panel at the left of the screen.

Select the markings you want to disable and, within the inspector, uncheck the first 
(or more) box in the Playback section. 

The advantage of using GMT curves: they linger on
Aside from giving you the flexibility of drawing your custom shapes, GMT automa-

tion curves have a major advantage over expression markings: they are part of the 
score (commands are hidden texts over the staff) and most importantly, they are 
carried over to the MIDI file when using Sibelius export function .

Sibelius expression markings are not stored as MIDI information in the score. They are interpret-
ed in real-time by the playback engine. When exporting to a MIDI file, any expression marking 
information will be lost, but GMT’s curves will be preserved.
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Configuring the automation color tabs
The upper color tabs are fully configurable. To do so, open the configuration dialog  

with the CFG button in the lower right part of GMT’s window.

The configuration “CFG” button in the lower right of GMT’s window

The configuration dialog will show up:

GMT’s configuration/preferences dialog
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Up to eight (8) tabs can be enabled at the same time. Each row in the form sets the 
properties for a given tab:

Tab properties inside the configuration dialog

For each tab you can set up:

	◼ Enable/disable: Use this checkbox to show/hide the tab.

	◼ MIDI CC controller: Choose which MIDI continuous controller 

	◼ Color: Pick a color between the nine possibilities 

	◼ Label: Use a three letter text which will be displayed as label for the tab.

Loading Factory defaults
At any time you can go back to GMT’s factory default settings. Click on the Load 

Defaults button in the lower left  of the configuration dialog.
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Working with Phantom Notes

With GMT, you can insert Phantom or “hidden” notes. Phantom notes are MIDI 
command based, and they are performed by the playback engine, but do not affect 
the written score at all.

Filling  performance gaps
With Phantom notes, it is possible to fill in passages where notation may not be 

fully explicit. For example, in a harp glissando, it is customary to write only the first 
notes, and hint the rest with a line.

The playback engine will normally consider only the written notes in the score, 
missing out the interpretation of the glissando line. 

With phantom notes, it is possible to add these notes. The written score (i.e. the 
spacing and layout) will not be affected at all.

To activate the Phantom notes tool, click the phantom (ghost) icon on the toolbar.

Click the Phantom tool to insert phantom notes

Now you can insert phantom notes. Click and drag over the piano roll grid to insert 
notes.

7 
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The phantom tool inserts phantom notes

You can now complete the performance; notice how phantom notes are shown in 
green, and written notes in red.

 

Modifying phantom notes
You can manipulate the length and position of phantom notes just as you do with 

the sound of written notes. It is also possible to edit their velocities (using the veloc-
ity lane).

Erasing Phantom notes
Use the mouse right button to activate the eraser. Drag over a phantom note and it 

will be removed. 
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Using Phantom notes as key switches
Another use for phantom notes is to trigger key switches. Some libraries reserve 

certain notes to change the sound / articulation of the current patch.

With phantom notes you can hit these notes without affecting the written score at 
all.

In the following example, we use key switches to change the articulation sound of 
the violin. In this case, the patch comes with these key switches (among others):

Note name MIDI number Articulation
C1 #24 Short sforzato

E1 #28 Pizzicato

G1 #31 Staccato

 

We insert the corresponding phantom notes right before the notes whose sound we 
want to change. 

Using phantom notes as key switches

About MIDI octave numbering
Be careful when looking for key switches specifications in your sound library man-

ual. There are two main conventions for numbering the octaves in the MIDI world: 
calling Middle C “C3” or “C4”. 

In both cases middle C is always MIDI note number #60.
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Sibelius calls middle C “C4”. Many sequencers/DAWs utilize the “C3” convention, 
as is in the early days of MIDI. So watch out for the octave numbering system. If your 
library says “D0”(D-zero) for legato, you will probably need to add one octave to 
make it work  in Sibelius/GMT. Write the key switch on “D1” (D-one). 



The Graphical Tempo Module

GMT’s tempo module enables you to view and modify the tempo (BPM) of your 
score graphically while using a set of new and unique tools. 

Now you can enhance the realism of your playback by creating custom ritardandos, 
accelerandos, or subtle time inflections that breathe life into your MIDI mockup.

Opening the tempo module
Click on the TEMPO tab located at the left of the time line. This will unfold the tem-

po track.

Use the pencil (left mouse button) to add or remove nodes from the tempo curve.

Erasing nodes
To erase nodes, click the right mouse button and drag to activate the eraser tool.

8 
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Zoomming in and out
If you need to draw the curve with more precision, you can set the vertical BPM 

viewing range. To do so, use GMT’s Pendulum zoom control. 

The Pendulum zoom control (inspired by old metronome sticks) has two weights 
– the upper and the lower one. Adjust each one at your discretion to achieve a small-
er or greater vertical BPM range.

Resizing the tempo Track
To enlarge the whole tempo track, GMT’s brings in the resize lever control. 
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The lever has three positions. 

	◼ Top: sets the tempo track height to the smallest (default) size.

	◼ Middle: sets a mid-size height

	◼ Bottom:  sets the tempo track to fill completely to the bottom of the GMT 
window.

Editing Options

Setting the snapping grid
Choose from the combo box to snap your node positions to a note value.

Selecting the node type.
Use this switch to select the type of node (jump or ramp) you want to work with. 

Jump nodes change the curve instantaneously, while ramp nodes create a smooth 
transition between values.

The Chomp mode
GMT’s tempo module introduces a new option for drawing the curve: the chomp 

mode. Click on the “cookie”button to activate it.

How it works:
When chomp mode is active, you can drag and draw the curve, and the alterations 

will be limited to the dragging range.

In standard (traditional) mode, adding a new node would make the tempo curve 
maintain the node’s value until the end of the score or until another node is encoun-
tered to the right.
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Chomp modeStandard mode

In this way, you are “biting” (chomping) the curve rather than setting a level for 
what comes next.

 The chomp mode comes in handy, for example, when you need to add small ritar-
dandos at the end of a measure.

Working with written tempo indications
Aside from the curve nodes you insert with GMT, tempo indications written in the 

score -  system tempo text objetcs- also modify the tempo curve.

These are displayed in GMT as text boxes containing the respective indication.
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Overriding a written indication
If you draw (drag the msouse) the curve over the region where the tempo indication 

(e.g. “molto rit.”) is in effect, GMT will automatically disable that written indication 
from playback and replace its behavior with your newly inserted nodes. 

You can identify this change by observing the dimming of the text box.
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Reestablishing the written indication
If you wish to restore the original behavior for the written tempo indication, simply 

click on the dimmed text box, and GMT will re-enable it, removing nodes that over-
lap with it.
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Known limitations and tips

Though we are committed to make our best efforts in order to provide you with the 
best user experience, there are some GMT limitations we want you to know, which 
are present in the current version.

Here are some tips as well, so you can make the most out of the plugin:

1. Prefer GMT’s playback button
GMT provides feedback for the playback line position while Sibelius is playing. This 

is technically possible only if playback is started from GMT’s play button. 

If you start playback from Sibelius, you will hear all your GMT edits, but you won’t 
see the GMT’s playback line moving.

2. Editing/Soloing while in playback
While Sibelius is playing, edits  can actually be done in GMT and they will be  stored 

in the score! But changes will not be heard until playback is stopped and restarted. 

Muting and Soloing a staff while in playback behave in the same way. They will not  
take effect until the next play.

3. Changing the score from Sibelius while GMT is open
If you change notes, or delete MIDI commands from within the score (i.e. using 

Sibelius interface) while GMT is open, you will find that those edits are not reflected 
automatically in the piano roll, until you re-open it.

The “live refresh” is a feature we are working on, but in the meantime, we recom-
mend closing GMT’s window while going back to notation editing.

4. Working with large passages
The GMT plugin sends all information in the selected region to the piano roll win-

dow before showing it on screen. This process is generally fast, especially if you are 
working with one or two staves and passages below a hundred (100) measures long. 

As more instruments and measures are added, you will experience a certain delay 
before the piano roll appears. The waiting time will depend on the complexity of the 
score (more notes, more information) and your computer processing power.

5. Opening many staves at the same time
Although GMT has no technical limit in the amount of staves it can handle at the 

same time, you will find that its interface is designed (and works better) if used only 
with a few of them at a time. A maximum of four or five staves is recommended. 
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From there up, it will depend on your screen resolution and your input device skills. 

Remember you can always edit as many staves as you want if you open them in 
groups.
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